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A well-conceived business plan is essential to the success of an enterprise. Whether you are starting up a venture, seeking additional capital for an existing product line, or proposing a new activity for a corporate division, you will have to write a plan detailing your project's resource requirements, marketing decisions, financial projections, production demands, and personnel needs. The plan must reflect the viewpoint of three constituencies: the customer, the investor, and the producer. Too many business plans focus excessively on the producer.
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We’ve gathered the most useful collection of business plan PDF templates and samples, including options for organizations of any size and type.
On this page, you’ll find free PDF templates for a simple business plan , small business plan , startup business plan , and more.
Simple Business Plan PDF Templates
These simple business plan PDF templates are ready to use and customizable to fit the needs of any organization.
Simple Business Plan Template PDF

This template contains a traditional business plan layout to help you map out each aspect, from a company overview to sales projections and a marketing strategy. This template includes a table of contents, as well as space for financing details that startups looking for funding may need to provide. 
Download Simple Business Plan Template - PDF
Lean Business Plan Template PDF

This scannable business plan template allows you to easily identify the most important elements of your plan. Use this template to outline key details pertaining to your business and industry, product or service offerings, target customer segments (and channels to reach them), and to identify sources of revenue. There is also space to include key performance metrics and a timeline of activities. 
Download Lean Business Plan Template - PDF
Simple 30-60-90 Day Business Plan Template PDF

This template is designed to help you develop and implement a 90-day business plan by breaking it down into manageable chunks of time. Use the space provided to detail your main goals and deliverables for each timeframe, and then add the steps necessary to achieve your objectives. Assign task ownership and enter deadlines to ensure your plan stays on track every step of the way.
Download Simple 30-60-90 Day Business Plan Template
PDF | Smartsheet
One-Page Business Plan PDF Templates
The following single page business plan templates are designed to help you download your key ideas on paper, and can be used to create a pitch document to gain buy-in from partners, investors, and stakeholders.
One-Page Business Plan Template PDF

Use this one-page template to summarize each aspect of your business concept in a clear and concise manner. Define the who, what, why, and how of your idea, and use the space at the bottom to create a SWOT analysis (strengths, weaknesses, opportunities, and threats) for your business. 
Download One-Page Business Plan Template
If you’re looking for a specific type of analysis, check out our collection of SWOT templates .
One-Page Lean Business Plan PDF

This one-page business plan template employs the Lean management concept, and encourages you to focus on the key assumptions of your business idea. A Lean plan is not stagnant, so update it as goals and objectives change — the visual timeline at the bottom is ideal for detailing milestones. 
Download One-Page Lean Business Plan Template - PDF
One-Page 30-60-90 Day Business Plan Template

Use this business plan template to identify main goals and outline the necessary activities to achieve those goals in 30, 60, and 90-day increments. Easily customize this template to fit your needs while you track the status of each task and goal to keep your business plan on target. 
Download One-Page 30-60-90 Day Business Plan Template
For additional single page plans, including an example of a one-page business plan , visit " One-Page Business Plan Templates with a Quick How-To Guide ."
Small Business Plan PDF Templates
These business plan templates are useful for small businesses that want to map out a way to meet organizational objectives, including how to structure, operate, and expand their business.
Simple Small Business Plan Template PDF

A small business can use this template to outline each critical component of a business plan. There is space to provide details about product or service offerings, target audience, customer reach strategy, competitive advantage, and more. Plus, there is space at the bottom of the document to include a SWOT analysis. Once complete, you can use the template as a basis to build out a more elaborate plan. 
Download Simple Small Business Plan Template
Fill-In-the-Blank Small Business Plan Template PDF

This fill-in-the-blank template walks you through each section of a business plan. Build upon the fill-in-the-blank content provided in each section to add information about your company, business idea, market analysis, implementation plan, timeline of milestones, and much more.
Download Fill-In-the-Blank Small Business Plan Template - PDF
One-Page Small Business Plan Template PDF

Use this one-page template to create a scannable business plan that highlights the most essential parts of your organization’s strategy. Provide your business overview and management team details at the top, and then outline the target market, market size, competitive offerings, key objectives and success metrics, financial plan, and more.
Download One-Page Business Plan for Small Business - PDF
Startup Business Plan PDF Templates
Startups can use these business plan templates to check the feasibility of their idea, and articulate their vision to potential investors.
Startup Business Plan Template

Use this business plan template to organize and prepare each essential component of your startup plan. Outline key details relevant to your concept and organization, including your mission and vision statement, product or services offered, pricing structure, marketing strategy, financial plan, and more.
Download Startup Business Plan Template
Sample 30-60-90 Day Business Plan for Startup

Startups can use this sample 30-60-90 day plan to establish main goals and deliverables spanning a 90-day period. Customize the sample goals, deliverables, and activities provided on this template according to the needs of your business. Then, assign task owners and set due dates to help ensure your 90-day plan stays on track.
Download Sample 30-60-90 Day Business Plan for Startup Template 
For additional resources to create your plan, visit “ Free Startup Business Plan Templates and Examples .”
Nonprofit Business Plan PDF Templates
Use these business plan PDF templates to outline your organization’s mission, your plan to make a positive impact in your community, and the steps you will take to achieve your nonprofit’s goals.
Nonprofit Business Plan Template PDF

Use this customizable PDF template to develop a plan that details your organization’s purpose, objectives, and strategy. This template features a table of contents, with room to include your nonprofit’s mission and vision, key team and board members, program offerings, a market and industry analysis, promotional plan, financial plan, and more. This template also contains a visual timeline to display historic and future milestones.
Download Nonprofit Business Plan Template - PDF
One-Page Business Plan for Nonprofit Organization PDF 

This one-page plan serves as a good starting point for established and startup nonprofit organizations to jot down their fundamental goals and objectives. This template contains all the essential aspects of a business plan in a concise and scannable format, including the organizational overview, purpose, promotional plan, key objectives and success metrics, fundraising goals, and more.
Download One-Page Business Plan for Nonprofit Organization Template - PDF
Fill-In-the-Blank Business Plan PDF Templates
Use these fill-in-the-blank templates as a foundation for creating a comprehensive roadmap that aligns your business strategy with your marketing, sales, and financial goals.
Simple Fill-In-the-Blank Business Plan PDF
The fill-in-the-blank template contains all the vital parts of a business plan, with sample content that you can customize to fit your needs. There is room to include an executive summary, business description, market analysis, marketing plan, operations plan, financial statements, and more. 
Download Simple Fill-In-the-Blank Business Plan Template - PDF
Lean Fill-In-the-Blank Business Plan PDF

This business plan is designed with a Lean approach that encourages you to clarify and communicate your business idea in a clear and concise manner. This single page fill-in-the-blank template includes space to provide details about your management team, the problem you're solving, the solution, target customers, cost structure, and revenue streams. Use the timeline at the bottom to produce a visual illustration of key milestones. 
Download Fill-In-the-Blank Lean Business Plan Template - PDF
For additional resources, take a look at " Free Fill-In-the-Blank Business Plan Templates ."
Sample Business Plan PDF Templates
These sample business plan PDF templates can help you to develop an organized, thorough, and professional business plan.
Business Plan Sample 

This business plan example demonstrates a plan for a fictional food truck company. The sample includes all of the elements in a traditional business plan, which makes it a useful starting point for developing a plan specific to your business needs.
Download Basic Business Plan Sample - PDF
Sample Business Plan Outline Template

Use this sample outline as a starting point for your business plan. Shorten or expand the outline depending on your organization’s needs, and use it to develop a table of contents for your finalized plan.
Download Sample Business Plan Outline Template - PDF
Sample Business Financial Plan Template

Use this sample template to develop the financial portion of your business plan. The template provides space to include a financial overview, key assumptions, financial indicators, and business ratios. Complete the break-even analysis and add your financial statements to help prove the viability of your organization’s business plan.
Download Business Financial Plan Template
PDF  | Smartsheet
For more free, downloadable templates for all aspects of your business, check out “ Free Business Templates for Organizations of All Sizes .”
Improve Business Planning with Real-Time Work Management in Smartsheet
Empower your people to go above and beyond with a flexible platform designed to match the needs of your team — and adapt as those needs change. 
The Smartsheet platform makes it easy to plan, capture, manage, and report on work from anywhere, helping your team be more effective and get more done. Report on key metrics and get real-time visibility into work as it happens with roll-up reports, dashboards, and automated workflows built to keep your team connected and informed. 
When teams have clarity into the work getting done, there’s no telling how much more they can accomplish in the same amount of time.  Try Smartsheet for free, today.
Discover why over 90% of Fortune 100 companies trust Smartsheet to get work done.

Writing a Winning Business Plan
By alex ryzhkov, introduction.
A business plan is the foundation on which an organization is built. It outlines the goals, objectives, and strategies for the business, as well as the resources needed to implement them. A good business plan should include detailed financial projections and plans for achieving the desired goals, and it must be supported by measurable objectives. It can be used to raise capital, track progress, review performance, and set goals.
The purpose of a business plan is to provide direction, focus, and structure to the organization. It helps to identify potential opportunities, assess financial resources and capabilities, anticipate problems and risks, and provide a roadmap for achieving desired results. It also serves as a communication tool with investors, lenders, and other stakeholders.
There are many advantages to having a business plan. A well-written business plan provides the vision and direction necessary to achieve success. It serves as a roadmap for setting short-term and long-term goals, as well as for managing resources more effectively. Additionally, it helps to attract investors and secure financing, as well as to build credibility with stakeholders. Finally, it provides a measure of accountability, allowing the business to track progress against goals.
Research Your Market
Creating a winning business plan begins with research. To make sure that your business plan is primed for success, you'll need to take the time to do the necessary research to get the basics down.
Understand the Industry
Make sure you understand the larger industry you are entering. You'll need to do your research on basic industry trends, consumer preferences, and other factors that could potentially impact your business. Doing this research now can save you a lot of time and energy down the road.
Research Your Competitors
It's important to take some time to research your current and potential competitors. Do an analysis of their strengths and weaknesses, their pricing, and how your business plan can differentiate you. Make sure you understand the competitive landscape before finalizing your business plan.
Define Your Target Audience
Now it's time to define your target audience. Who is the specific audience you are going to be targeting with your business? Consider factors such as age, gender, location, interests, and other traits that will help you tailor your plan to appeal to this audience.
Building Your Company's Profile
Drafting a business plan is one of the most important steps you can take to ensure the success of your business. The document outlines your business objectives and provides the roadmap to meeting those objectives. To properly create a winning business plan, it's important to understand what the company will bring to the table. To do this, you’ll need to identify the mission, set objectives, and identify opportunities and strengths.
Identify Your Business Mission
First, you need to identify your business mission. This requires you to sit down and brainstorm what your goals are for the business and what services and/or products you will offer. It's important to have a concrete idea of what your business will strive to achieve, as this will inform the rest of the planning process.
Set Objectives
Once you have established your business mission, it’s time to set objectives. Goals and objectives are slightly different, and should complement each other. Goals are broader and long-term, while objectives are more concrete and short-term. When setting objects, think of what you want to accomplish in the near future. This can include revenue goals, providing specific services, or introducing new products.
Identify Opportunities and Strengths
Identifying opportunities and strengths is important to give your business plan a market positioning edge and goals to aim for. Opportunities are typically present in the form of unexploited market segments and customer niches, while strengths can be any advantages your business has, such as knowledgeable staff or experience in a certain industry. Once you have identified opportunities and strengths, you can use them when crafting the marketing and promotion plan for your business.
By understanding your mission, setting objectives, and identifying opportunities and strengths, you'll have a strong starting point for anybody looking to create a winning business plan.
Writing a Financial Plan
As part of your business plan, writing a financial plan is essential to mapping out your business strategy. Writing a comprehensive financial plan is an important process that requires careful consideration of various different factors. Here we will review the three main components to consider when going through this process: estimating expenses, analyzing revenue streams and fundraising and sourcing.
Estimate Expenses
The first step when writing a financial plan is to calculate the estimated costs associated with launching and running your business. This includes startup costs such as purchasing equipment and materials and operational costs such as wages, taxes, and utilities. Additionally, you also need to consider potential costs associated with unforeseen circumstances or opportunities – such as expanding your business or taking advantage of potential marketing opportunities.
Developing a projected budget and cash flow statement is also essential in this process.These documents will help you to understand how much cash will be required to launch your business, as well as the amount of capital you will need to sustain the business. It’s important to take into account that creating accurate financial projections is an iterative process and will take time to refine and solidify.
Analyze Revenue Streams
In addition to estimating your expenses, it’s also critical to analyze your potential revenue streams. To do this, you’ll need to create an income statement that analyzes your potential profits or losses over a specified period of time. It will help to focus especially on sources of consistent income. Consider factors such as market conditions, competition, pricing strategy, and potential customer base when estimating your potential profits.
Fundraising and Sourcing
Finding the funds to support your startup costs is an essential part of the financial planning process. It’s important to understand the various options available for financing your business, such as taking out a loan, utilizing credit cards, crowd funding or seeking out angel investors. Consider the various different sources available, such as government grants, loans from family and friends, or working with financial institutions. Research your options and choose a financing source that best fits your situation and budget.
Your financial plan is an important part of your business plan and determining the funds available to support your business venture. By estimating your expenses, analyzing potential revenue streams and researching the best sources of financing, you’ll be able to develop a comprehensive financial plan that helps get your business off the ground.
Documentation and Presentation
Creating an effective business plan is essential for the success of any business venture. It should include important financial figures, detailed market analysis, and a well-defined mission statement. It should also be organized and presented in a professional manner. Writing style, formatting, and visual aids are important elements to include when crafting a business plan. In this section, we will discuss these elements further.
Formatting can help make a business plan easier to read and understand. The same formatting should generally be maintained throughout the document, such as font size and type, line spacing, paragraph indentation, and alignment. Additionally, chapters should be clearly delineated by including a heading and sub-heading to introduce each new topic. Include a table of contents and pagination to make navigation within the document a breeze.
Writing Style
When crafting the content for a business plan, it's important to utilize a professional and consistent writing style. Stick to the facts and avoid flowery language. Be clear, concise, and to the point. When introducing figures, use commas between thousands, and include appropriate units of measure, such as dollars and cents. For example, “The cost of the project was $2,000,000.”
Visual Aids
Text can become dull and boring, so dynamic visual elements can liven up a business plan. This can include charts, diagrams, graphs, and images. Visual aids can help readers better understand the information presented in the plan. For example, a graph can illustrate the potential profit margins of the business, while a chart can display the total cost of the project.
Incorporating these three key elements into a business plan can help create an effective plan that conveys the message you are attempting to deliver. Documentation and presentation should never be overlooked as an essential part of the business plan creation process.
Finishing Your Business Plan
It's almost time to complete your business plan and reap the benefits of all the hard work you've put into it. Before submitting or presenting your plan, you must review and revise it to make sure all the information is accurate and logical.
Describe Your Exit Strategy
It is important to include a strategy for exiting your business. An exit strategy is the plan for the eventual sale of your business. This should include details regarding potential buyers, the specifics of the sale process, and the potential timeline. There are several options to consider when developing this strategy, and it is a good idea to get advice from a financial or legal advisor.
Review and Edit
Before submitting your business plan, review your document for errors in spelling, grammar, and syntax. You may want to consider having a qualified editor or proofreader check for common mistakes.
You should also review the structure and flow of your business plan. Read it from beginning to end to check for logical flow and readability. Make sure your statement of purpose and objectives are clear and your reader will understand them.
Final Revisions
Finally, review your financial projections with a financial advisor or accountant to make sure the figures are accurate and feasible. Also, make sure that any pricing information included in your plan reflects the current market and suits the needs of your customers.
When you are happy with the final version of your business plan, all that is left to do is to submit or present it and cross your fingers that it will help you achieve your business goals. Good luck!
Creating a comprehensive and effective business plan is a key element of business success. A winning business plan provides entrepreneurs with a roadmap to profitability and helps create clarity and ensure that everyone involved in the venture is headed in the same direction. Formulating an effective and successful business plan requires considerable research and careful planning. The preparation of a business plan is an invaluable exercise that can help entrepreneurs to better understand their businesses and offer them a competitive edge in the marketplace.
Benefits of Creating a Winning Business Plan
	It aids in developing the strategy for the business and answers many of the questions related to the long-term success of the venture.
	It shows the entrepreneurs their understanding of the industry and the external environment that their businesses operate in.
	It gives a detailed assessment of the resources required to make the business successful, helping entrepreneurs to allocate appropriate funds.
	It provides a platform to access capital from investors and financial institutions.
	It encourages entrepreneurs to constantly evaluate their business operations, seek feedback and make necessary changes.

Final Notes
Careful preparation is key to writing an effective and successful business plan. A winning business plan provides entrepreneurs with a clear sense of direction and a better understanding of their venture as well as its environment. In order to make the most of a business plan, entrepreneurs should be willing to be involved in the process of creating the document and not see it as a one-off activity. Taking the time to review and update the plan regularly will ensure that the goals of the business are consistently met.
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Writing Winning Business Plans
By garrett sutton, esq, this book will teach you how to:.
	Attract the funding you need
	Identify strengths and weaknesses
	Deal with competition
	Understand your financials
	Use your plan in competitions around the world

Description
Rich Dad/Poor Dad   author Robert Kiyosaki says, “The first step in business is a great business plan. It must be a page turner that hooks and holds a potential investor. Garrett Sutton’s   Writing Winning Business Plans   is THE BOOK for key strategies on preparing winning plans for both business and real estate ventures.”
Crisply written and featuring real life illustrative stories,   Writing Winning Business Plans   discusses all the key elements for a successful plan. Topics include clarifying your business vision, understanding your financials and analyzing your competition. Also covered are how to wisely use your business plan as a tool and how to attract funding for your new or existing businesses. To write a winning business plan requires reading Garrett Sutton’s dynamic book on the topic. Writing Winning Business Plans provides the insights and direction on how to do it right.
As business plan competitions become more popular around the world   Writing Winning Business Plans   also discusses how to enter and how to win these ever more lucrative contests. In addition, how to quickly interest a potential investor, also known as the elevator pitch, is explained. And, as opportunities arise around the world, how to present your plan in various countries is explored.
Writing Winning Business Plans   is the complete compendium for this essential entrepreneurial rite of passage – preparing a winning business plan.

Praise for  Writing Winning Business Plans
“Business owners at every stage of their endeavor should consider reading Writing Winning Business Plans – to bone up on business basics, learn how to write a business plan, and, equally important, to remind themselves of how close they’ve adhered to or how far they’ve come from their original vision.”   Blueink Review
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Product Description
Publication Date: May 01, 1985
A well-conceived business plan is essential to the success of an enterprise. Whether you are starting up a venture, seeking additional capital for an existing product line, or proposing a new activity for a corporate division, you will have to write a plan detailing your project's resource requirements, marketing decisions, financial projections, production demands, and personnel needs. The plan must reflect the viewpoint of three constituencies: the customer, the investor, and the producer. Too many business plans focus excessively on the producer.
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How to Write a Winning Business Plan (HBR OnPoint Enhanced Edition) ^ 584X --> How to Write a Winning Business Plan (HBR OnPoint Enhanced Edition)
This is an enhanced edition of HBR article 85314, originally published in May 1985. HBR OnPoint articles include the full-text HBR article plus a summary of key ideas and company examples to help you...

How to Write a Great Business Plan ^ 97409 --> How to Write a Great Business Plan
Every seasoned investor knows that detailed financial projections for a new company are an act of imagination. Nevertheless, most business plans pour far too much ink on the numbers--and far too...

How to Write a Great Business Plan (Harvard Business Review Classics) ^ 2142 --> How to Write a Great Business Plan (Harvard Business Review Classics)
Judging by all the hoopla surrounding business plans, you'd think the only things standing between would-be entrepreneurs and spectacular success are glossy five-color charts, bundles of...
Copyright Permissions
If you'd like to share this PDF, you can purchase copyright permissions by increasing the quantity.
Order for your team and save!
Note: Quantity pricing discounts will be reflected at Checkout, prior to submitting your order.
How to Write an HVAC Business Plan + Free Sample Plan PDF

Elon Glucklich
8 min. read
Updated February 16, 2024
Download: Free one-page HVAC sample business plan
No one wants to spend hours living or working in sweltering heat or bitter cold.
Over 3 million heating and air conditioning systems are replaced in the United States each year. As a result, the HVAC industry employs 1.5 million people and generates over $150 billion in annual revenue.
There are plenty of opportunities for skilled technicians looking to start or grow an HVAC installation and maintenance business. But just because demand is high, it doesn’t mean that anyone who knows how to install equipment can successfully enter the market.
Writing a business plan will help you align your services with the opportunity in your area. It also matches your vision for the business with your financial resources. And you’ll need to write a plan if you’re seeking a bank loan or investment for your business.
This article will help ensure that your plan includes the right information and supporting data to highlight your HVAC business, and convince investors that you’ll run an efficient operation that’s profitable over the long term.
	What should you include in an HVAC business plan?

Don’t get too hung up on trying to hit a certain number of pages in your business plan. Just focus on the aspects of your plan that are most important based on what you want your plan to accomplish. If you’re looking for in-depth guidance, Bplans can guide you through writing your full business plan in detail .
In this article, we’ll cover a few of the business plan components you’ll likely include in your HVAC business plan:
	Executive Summary
	Market Analysis
	HVAC Services and Pricing
	Operations Plan
	Marketing and Sales Strategy
	Company Summary and Funding Needs
	Financial Plan and Forecasts

As you write your plan, be sure to consider the full range of services you might be able to offer customers. For instance, you might not only provide installation, maintenance, and repair services but also sell HVAC units, smart thermostats and related products. 
Including all these possibilities in your plan will help you determine the feasibility of adding revenue streams and opportunities to enhance customer value through product sales alongside your services. Just make sure your plan details strategies for providing whichever services you decide to offer.
Here’s an example of an HVAC business plan outline.

What’s your biggest business challenge right now?
	The 7 elements of an effective HVAC business plan

1. Executive summary
The executive summary outlines the broad vision and opportunity for your HVAC business. It provides readers with a brief, high-level overview of your plan, one that emphasizes your unique value proposition and competitive advantages.
Write a mission statement , which describes the purpose of your business. Maybe you aim to provide energy-efficient and environmentally sustainable HVAC systems. Or perhaps you provide top-notch customer service for both residential and commercial customers.
Touch on key factors for the success of your business, like your location, service offerings and staff.
2. Market analysis
Without understanding the needs of customers in your target area, you won’t know which products or services will generate the most sales.
That’s why conducting a thorough market analysis is crucial. What do homeowners and commercial landlords in your area need? If you’re in a warm climate, air conditioning systems will be in high demand. But a cold-weather market will drive demand for heating systems. Other factors to consider include the age and condition of buildings in your service area. 
Researching the market helps identify your target customer segments and understand their specific needs and preferences. This analysis should cover demographic details, purchasing behaviors, and the size of your target market . Additionally, provide an overview of the competitive landscape , identifying key players and their market positioning. Highlight industry trends, such as the growing demand for energy-efficient systems that support the potential success and relevance of your HVAC business.
3.  HVAC services and pricing
List the full range of HVAC services your business plans to provide, such as installation, maintenance, and repair services for heating, ventilation, and air conditioning systems.
You should also outline your pricing strategy . Detail how you intend to offer competitive rates while ensuring profitability. Whether you adopt a value-based pricing model or a cost-plus approach, this section should explain how your pricing aligns with market expectations and customers’ willingness to pay.
4. Operations plan
Finding customers is one challenge. Once you have them, you’ll need a solid operations plan to ensure you can meet their needs. This section of your plan details the day-to-day operational aspects of your business.
You’ll need to account for delivering your HVAC services and all of the related logistics of service delivery, the equipment required, and any business policies or standards you intend to implement. If you have employees, spend time in this section covering how you will coordinate with them to ensure they have the right equipment and information when they head to a job site.
5. Marketing and sales strategy
Your marketing and sales strategy expands on your market research. This section outlines the methods you’ll use to attract and retain customers.
You should start by identifying the most effective marketing channels for reaching your target market. Take a look at how other HVAC companies are promoting their services. Are they advertising online , or on TV and radio? Do they have active social media presences, or are they relying on more traditional methods like printed flyers or partnerships with real estate agencies?
Once you understand where your target audience gets information about HVAC services, write down your strategies for investing in these marketing and sales channels. Try to include estimated costs and projected return on investment for each channel.
Remember, different product and service offerings might require different marketing tactics. For instance, you might want to promote the energy efficiency aspects of your service online. But customers seeing your ads on television might be more interested in your pricing versus competitors.
6. Company summary
In the business overview section, detail your business model , including the legal structure and geographical location of your operation. 
Briefly list the range of HVAC services you offer. You’ve already provided details on these in the services and pricing section, but the company overview is where you explain how these services address specific customer needs or market gaps. This part of the plan should clearly articulate the problems your business solves, emphasizing the value and reliability your company brings to the HVAC market.
You can also include a bit about your management team, highlighting the key roles and the expertise each member brings to the HVAC industry. And if you’re seeking bank or investor funding for your business, you can lay out the funding request and explain how you intend to use the funds here.
7. Financial Plan
The financial plan should present detailed financial projections for your HVAC business, giving a reader an understanding of how you expect the business to perform in the short and long term.
Include revenue , costs , and profitability , as well as a cash flow statement , income statement , and balance sheet .
If you’re starting a new business, provide details on startup costs , revenue streams, and funding requirements.
Remember, forecasts are just educated guesses. At the same time, the goal of your financial plan is to demonstrate your cleaning service’s ability to generate a profit. If your numbers don’t show a pathway to profitability, you may need to rethink your service offerings or marketing strategy.
	Key considerations for writing an HVAC business plan

Building supplier relationships and managing how cash moves in and out of your business is essential. So is understanding what your customers want. To write an HVAC business plan that helps you streamline operations, reduce wasteful spending, or get a bank loan, consider addressing these points.
1. Go deep with your market research
Utilize data from public sources like the U.S. Census Bureau to drill down on the number of households in your area. You can also use Google to research commercial properties in your area that might need HVAC services, like office buildings or retirement homes.
2. Make your credentials clear
Highlight your team’s expertise, certifications, and accreditations. They serve as proof of your credibility to clients, lenders and investors.
3. Professional training and standards
Document your plans for committing to ongoing training on the latest HVAC technologies and safety standards.
4. Supplier relationships and inventory
Detail your plans for sourcing your HVAC systems, and how you’ll store the systems before delivering them. Also, describe your logistical arrangements for job site deliveries, including transportation needs, such as whether you will need a company van.
5. Accounts receivable and accounts payable
It’s likely you won’t immediately be paid in full for your services. Make sure you account for this in your forecasts. Incorporate realistic financial projections considering delayed payments for services and the gradual settlement of equipment expenses.
	Download your free HVAC one page sample business plan

Download your HVAC business plan sample now for free, or explore the Bplans gallery of over 550 sample business plans if you want to see plans for other industries.
Writing a business plan for your HVAC business boosts your chance of success for a variety of reasons . We’ve mentioned its importance if you’re seeking a loan or investment. But just going through the process of thinking through each aspect of your operation will help make sure you don’t leave any stone unturned as you build a successful business.

See why 1.2 million entrepreneurs have written their business plans with LivePlan

Elon is a marketing specialist at Palo Alto Software, working with consultants, accountants, business instructors and others who use LivePlan at scale. He has a bachelor's degree in journalism and an MBA from the University of Oregon.
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The quickest way to turn a business idea into a business plan
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Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print.  To do this, you will start with baseline content in a document, potentially via a form template.  Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to database information.  Following are the recommended action steps in sequence.  
Show the Developer tab
In Word, be sure you have the Developer tab displayed in the ribbon.  (See how here:  Show the developer tab .)
Open a template or a blank document on which to base the form
You can start with a template or just start from scratch with a blank document.
Start with a form template
Go to File > New .
In the  Search for online templates  field, type  Forms or the kind of form you want. Then press Enter .
In the displayed results, right-click any item, then select  Create. 
Start with a blank document 
Select Blank document .
Add content to the form
Go to the  Developer  tab Controls section where you can choose controls to add to your document or form. Hover over any icon therein to see what control type it represents. The various control types are described below. You can set properties on a control once it has been inserted.
To delete a content control, right-click it, then select Remove content control  in the pop-up menu. 
Note:  You can print a form that was created via content controls. However, the boxes around the content controls will not print.
Insert a text control
The rich text content control enables users to format text (e.g., bold, italic) and type multiple paragraphs. To limit these capabilities, use the plain text content control . 
Click or tap where you want to insert the control.

To learn about setting specific properties on these controls, see Set or change properties for content controls .
Insert a picture control
A picture control is most often used for templates, but you can also add a picture control to a form.

Insert a building block control
Use a building block control  when you want users to choose a specific block of text. These are helpful when you need to add different boilerplate text depending on the document's specific purpose. You can create rich text content controls for each version of the boilerplate text, and then use a building block control as the container for the rich text content controls.

Select Developer and content controls for the building block.

Insert a combo box or a drop-down list
In a combo box, users can select from a list of choices that you provide or they can type in their own information. In a drop-down list, users can only select from the list of choices.

Select the content control, and then select Properties .
To create a list of choices, select Add under Drop-Down List Properties .
Type a choice in Display Name , such as Yes , No , or Maybe .
Repeat this step until all of the choices are in the drop-down list.
Fill in any other properties that you want.
Note:  If you select the Contents cannot be edited check box, users won’t be able to click a choice.
Insert a date picker
Click or tap where you want to insert the date picker control.

Insert a check box
Click or tap where you want to insert the check box control.

Use the legacy form controls
Legacy form controls are for compatibility with older versions of Word and consist of legacy form and Active X controls.
Click or tap where you want to insert a legacy control.

Select the Legacy Form control or Active X Control that you want to include.
Set or change properties for content controls
Each content control has properties that you can set or change. For example, the Date Picker control offers options for the format you want to use to display the date.
Select the content control that you want to change.
Go to Developer > Properties .

Change the properties that you want.
Add protection to a form
If you want to limit how much others can edit or format a form, use the Restrict Editing command:
Open the form that you want to lock or protect.
Select Developer > Restrict Editing .

After selecting restrictions, select Yes, Start Enforcing Protection .

Advanced Tip:
If you want to protect only parts of the document, separate the document into sections and only protect the sections you want.
To do this, choose Select Sections in the Restrict Editing panel. For more info on sections, see Insert a section break .

If the developer tab isn't displayed in the ribbon, see Show the Developer tab .
Open a template or use a blank document
To create a form in Word that others can fill out, start with a template or document and add content controls. Content controls include things like check boxes, text boxes, and drop-down lists. If you’re familiar with databases, these content controls can even be linked to data.
Go to File > New from Template .

In Search, type form .
Double-click the template you want to use.
Select File > Save As , and pick a location to save the form.
In Save As , type a file name and then select Save .
Start with a blank document
Go to File > New Document .

Go to File > Save As .
Go to Developer , and then choose the controls that you want to add to the document or form. To remove a content control, select the control and press Delete. You can set Options on controls once inserted. From Options, you can add entry and exit macros to run when users interact with the controls, as well as list items for combo boxes, .
Adding content controls to your form
In the document, click or tap where you want to add a content control.
On Developer , select Text Box , Check Box , or Combo Box .

To set specific properties for the control, select Options , and set .
Repeat steps 1 through 3 for each control that you want to add.
Set options
Options let you set common settings, as well as control specific settings. Select a control and then select Options to set up or make changes.
Set common properties.
Select Macro to Run on lets you choose a recorded or custom macro to run on Entry or Exit from the field.
Bookmark Set a unique name or bookmark for each control.
Calculate on exit This forces Word to run or refresh any calculations, such as total price when the user exits the field.
Add Help Text Give hints or instructions for each field.
OK Saves settings and exits the panel.
Cancel Forgets changes and exits the panel.
Set specific properties for a Text box
Type Select form Regular text, Number, Date, Current Date, Current Time, or Calculation.
Default text sets optional instructional text that's displayed in the text box before the user types in the field. Set Text box enabled to allow the user to enter text into the field.
Maximum length sets the length of text that a user can enter. The default is Unlimited .
Text format can set whether text automatically formats to Uppercase , Lowercase , First capital, or Title case .
Text box enabled Lets the user enter text into a field. If there is default text, user text replaces it.
Set specific properties for a Check box .
Default Value Choose between Not checked or checked as default.
Checkbox size Set a size Exactly or Auto to change size as needed.
Check box enabled Lets the user check or clear the text box.
Set specific properties for a Combo box
Drop-down item Type in strings for the list box items. Press + or Enter to add an item to the list.
Items in drop-down list Shows your current list. Select an item and use the up or down arrows to change the order, Press - to remove a selected item.
Drop-down enabled Lets the user open the combo box and make selections.
Protect the form
Go to Developer > Protect Form .

Note:  To unprotect the form and continue editing, select Protect Form again.
Save and close the form.
Test the form (optional)
If you want, you can test the form before you distribute it.
Protect the form.
Reopen the form, fill it out as the user would, and then save a copy.
Creating fillable forms isn’t available in Word for the web.
You can create the form with the desktop version of Word with the instructions in Create a fillable form .
When you save the document and reopen it in Word for the web, you’ll see the changes you made.

Need more help?
Want more options.
Explore subscription benefits, browse training courses, learn how to secure your device, and more.

Microsoft 365 subscription benefits

Microsoft 365 training

Microsoft security

Accessibility center
Communities help you ask and answer questions, give feedback, and hear from experts with rich knowledge.

Ask the Microsoft Community

Microsoft Tech Community

Windows Insiders
Microsoft 365 Insiders
Was this information helpful?
Thank you for your feedback.
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	PDF HOW TO WRITE A BUSINESS PLAN
HOW TO WRITE A BUSINESS PLAN The purpose of this note is three-fold: To provide a set of guidelines on how to write a business plan. To highlight what a prospective investor or banker is, and is not, looking for in such a plan. To provide a summary check list of the attributes of good business plans.




	How to Write a Winning Business Plan
How to Write a Winning Business Plan by Stanley R. Rich and David E. Gumpert From the Magazine (May 1985) A comprehensive, carefully thought-out business plan is essential to the...




	PDF SUCCESSFUL business plan
at explaining the business plan as a planning tool rather than a formulaic exercise. Well done. " — Inc. Magazine " We are again using Successful Business Plan in my business honors course this semester. Must be working, as Penn State was just named (by Kaplan and Newsweek magazine) as the 'hottest school in the U.S. for student entre ...




	PDF Writing the Winning Business Plan
Having worked in the planning and the writing of hundreds of business plans and read thousands more, we have found that if you really want to write a business plan, you'll get there. It just takes a fair amount of dedicated time. Writing a business plan is similar to writing that thesis back in college or in graduate school.




	How to Write a Winning Business Plan
How to Write a Winning Business Plan By: Stanley R. Rich, David E. Gumpert A well-conceived business plan is essential to the success of an enterprise. Whether you are starting up a venture, seeking additional capital for an existing product line, or proposing a new… Length: 7 page (s) Publication Date: May 1, 1985




	How to Write a Business Plan: Guide + Examples
Download a free one-page plan template to write a useful business plan in as little as 30-minutes. Explore over 500 real-world business plan examples from a wide variety of industries. Try the business planning and growth tool trusted by over 1-million business owners.




	Write your business plan
Executive summary Briefly tell your reader what your company is and why it will be successful. Include your mission statement, your product or service, and basic information about your company's leadership team, employees, and location. You should also include financial information and high-level growth plans if you plan to ask for financing.




	How to Write a Winning Business Plan (HBR OnPoint Enhanced Edition
How to Write a Winning Business Plan (HBR OnPoint Enhanced Edition) By: Stanley R. Rich, David E. Gumpert A well-conceived business plan is essential to the success of an enterprise. Whether you are starting up a venture, seeking additional capital for an existing product line, or proposing a new… Length: 11 page (s) Publication Date: Jan 1, 2001




	Writing Winning Business Plans: How to Prepare a Business Plan that
Garrett Sutton's Writing Winning Business Plans is THE book for key strategies on preparing winning plans for both business and real estate ventures. Crisply written and featuring real...




	Download Free Business Plan Examples
What You'll Get: A complete business plan Unlike other blank templates, our business plan examples are complete business plans with all of the text and financial forecasts already filled out. Edit the text to make the plan your own and save hundreds of hours. A professional business plan template All 550 of our business plans are in the SBA-approved format that's proven to raise money from ...




	PDF How to Write a Great Business Plan
Business Plan neuvers create a vicious circle of inaccuracy that benefits no one. Don' t misunderstand me: business plans should include some numbers. But those numbers should appear mainly in the for m of a business model that shows the entrepreneurial team has thought through the key drivers of the venture's success or failure.




	Free PDF Business Plan Templates
Simple 30-60-90 Day Business Plan Template PDF. This template is designed to help you develop and implement a 90-day business plan by breaking it down into manageable chunks of time. Use the space provided to detail your main goals and deliverables for each timeframe, and then add the steps necessary to achieve your objectives.




	Business plans
How to Write a Winning Business Plan. Organizational Development Magazine Article. Stanley R. Rich; David E. Gumpert; A well-conceived business plan is essential to the success of an enterprise ...




	How To Write A Business Plan (2024 Guide)
Describe Your Services or Products. The business plan should have a section that explains the services or products that you're offering. This is the part where you can also describe how they fit ...




	PDF How to Write A Winning Business Plan
There are a number of reasons why you should write your business plan. 1. First, it is absolutely necessary that you provide a business plan to any prospective lender. The completed business plan communicates your ideas to others and provides the basis for your financing proposal. 2. The process of putting a business plan together forces you to ...




	PDF Writing a Winning Business Plan
Writing a Winning Business Plan Structural Guides & Practical Hints What it takes to write a business plan in 2024! Jack Derby, President, Derby Management Professor of the Practice, Tufts University Derby Entrepreneurship Center@Tufts [email protected] [email protected] 617-504-4222




	Writing a Winning Business Plan: A Step-by-Step Guide
By Alex Ryzhkov Introduction A business plan is the foundation on which an organization is built. It outlines the goals, objectives, and strategies for the business, as well as the resources needed to implement them.




	How to Write a Winning Business Plan (HBR OnPoint Enhanced Edition)
Product Description. This is an enhanced edition of HBR article 85314, originally published in May 1985. HBR OnPoint articles include the full-text HBR article plus a summary of key ideas and company examples to help you quickly absorb and apply the concepts. A well-conceived business plan is essential to the success of an enterprise.




	How to write a winning business plan : Mancuso, Joseph : Free Download
How to write a winning business plan by Mancuso, Joseph. Publication date 1985 Topics Small business, Venture capital, Business planning, Petites et moyennes entreprises, Capital à risques, Entreprises, Finanzierung, Geschäftsplan, Unternehmensgründung ... EPUB and PDF access not available for this item.




	Writing Winning Business Plans
Garrett Sutton's Writing Winning Business Plans is THE BOOK for key strategies on preparing winning plans for both business and real estate ventures." Crisply written and featuring real life illustrative stories, Writing Winning Business Plans discusses all the key elements for a successful plan. Topics include clarifying your business ...




	How to Write a Cleaning Service Business Plan
Download your cleaning service sample business plan PDF. Download this cleaning service sample business plan PDF for free right now, or visit Bplans' gallery of more than 550 sample business plans if you want more options. Don't get hung up on finding a sample business plan that exactly matches your cleaning service.




	PDF Writing the Winning Business Plan
Writing the Winning Business Plan Structural Guides & Practical Hints In the unplanned world of 2020 Jack Derby, Head Coach, Derby Management [email protected] Professor of the Practice Past Director, Tufts University Entrepreneurship Center Cummings Family Professor of Entrepreneurship [email protected] 617-504-4222




	Writing a Winning Business Plan
Compiling Your Marketing Plan Example: the board game makers The inventors and producers of a new board game might define their shortterm marketing objectives as: Objectives 1. Find a major wholesaler to take 50 per cent of production. 2. Expand a current local client base by creating an online presence.




	How to Write a Dog Grooming Business Plan + Free Sample Plan PDF
Tips for writing a dog grooming business plan. Understanding pet owners' needs and how you can best serve them is vital for writing a dog grooming business plan that you can actually use to help your business grow. As you write the plan, give some attention to these key points. 1. Consider your business structure. Choosing the right structure ...




	How to Write a Winning Business Plan
A well-conceived business plan is essential to the success of an enterprise. Whether you are starting up a venture, seeking additional capital for an existing product line, or proposing a new activity for a corporate division, you will have to write a plan detailing your project's resource requirements, marketing decisions, financial projections, production demands, and personnel needs.




	Takeaways from Fani Willis' stunning testimony in Georgia
Things quickly went off the rails. Willis didn't act much like a traditional witness and was more like a prosecutor, arguing with the defense attorneys, raising objections, making legal ...




	How to Write an HVAC Business Plan + Free Sample Plan PDF
The 7 elements of an effective HVAC business plan 1. Executive summary. The executive summary outlines the broad vision and opportunity for your HVAC business. It provides readers with a brief, high-level overview of your plan, one that emphasizes your unique value proposition and competitive advantages.. Write a mission statement, which describes the purpose of your business.




	Create a form in Word that users can complete or print
Show the Developer tab. If the developer tab isn't displayed in the ribbon, see Show the Developer tab.. Open a template or use a blank document. To create a form in Word that others can fill out, start with a template or document and add content controls.
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